### Elements of a Table

#### Tables

**Insert a Table:** Click the Insert tab, click the Table button, and select the number of rows and columns that you want.

**Add a Row or Column:** Click in a cell next to where you want to add a row or column. Click the Table Tools Layout tab, then click Insert Above , Insert Below , Insert Left , or Insert Right , depending on where you want the row or column to be added.

**Delete a Row or Column:** Click in a cell in the row or column you want to delete, click the Table Tools Layout tab, click the Delete button, then select Delete Row or Delete Column.

**Convert a Table to Text:** Select the table, click the Table Tools Design tab, and click Convert to Text button, choose how to separate the cells, and click OK.

**Manually Resize a Table Row or Column:** Click and drag the cell border.

**Automatically Resize a Table Row or Column:** Click within the table, click the Table Tools Layout tab, click the AutoFit button, and select an option.

**Merge Cells:** Select multiple cells that share a border, click the Table Tools Layout tab, and click the Merge Cells button.

**Split Cells:** Select a cell, click the Table Tools Layout tab, click the Split Cells button, enter the number of rows and columns, and click OK.

**Distribute Rows and Columns:** Click within the table, click the Table Tools Layout tab, click the Distribute Rows button to distribute the rows evenly, or click the Distribute Columns button to distribute the columns evenly.

**Apply a Table Style:** Click inside the table, click the Table Tools Design tab, and select a style from the Table Styles gallery.

**Apply Text Alignment:** Select the cell(s), click the Table Tools Design tab, and click the Borders button list arrow, select a border style, click the Borders button list arrow, and select a border option.

**Add Cell Shading:** Select the cell(s), click the Shading button list arrow, and select a color.

**Split a Table:** Click in the row where the second table will start, click the Table Tools Layout tab, and click the Split Table button.

### Navigating a Table

#### Navigating a Table

- **Next cell** ................. Tab
- **Previous cell** .............. Shift + Tab
- **Next row** .................. ↓
- **Previous row** .............. ↑
- **First cell in a row** ........ Alt + Home
- **Last cell in a row** .......... Alt + End
- **First cell in a column** ..... Alt + Page Up
- **Last cell in a column** ..... Alt + Page Down

#### Selecting Cells

- **Select a Single Cell:** Click in the lower-left corner of a cell, when the cursor changes to an arrow ; or triple-click a cell; or click the Table Tools Design tab, click Select button, and choose Select Cell.

- **Select a Row:** Click in the lower-left corner of a table; or click the Table Tools Design tab, click Select button, and choose Select Row.

- **Select a Column:** Click above a column, when the cursor changes to an arrow ; or click the Table Tools Design tab, click Select button, and choose Select Column.

- **Select an Entire Table:** Click the table selector button in the upper-left corner of a table; or click the Table Tools Design tab, click Select button, and choose Select Table.

#### Table Style Options

**Configure Table Style Options:** With the text cursor within the table, click the Table Tools Design tab, then check the check boxes in the Table Style Options group to toggle certain table elements. The appearance of these elements will vary, based on the current Table Style.

- **Header Row:** Applies special formatting to the first row of a table.
- **Total Row:** Applies special formatting to the final row of a table.
- **Banded Rows:** Alternates the shading for the body rows between two different colors.
- **First Column:** Applies special formatting to the first column in a table.
- **Last Column:** Applies a special formatting to the last column in a table.
- **Banded Columns:** Alternates the shading for body columns between two different colors.
<table>
<thead>
<tr>
<th>Graphics</th>
<th>Graphics</th>
<th>Styles, Themes, and Templates</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Insert a Picture:</strong> Place the text cursor where you want to insert a picture, click the <strong>Insert</strong> tab, click the <strong>Pictures</strong> button, select a picture, and click <strong>Insert</strong>.</td>
<td><strong>Delete an Object:</strong> Select an object, then press the <strong>Delete</strong> key.</td>
<td><strong>Apply a Theme:</strong> Click the <strong>Design</strong> tab, click the <strong>Themes</strong> button, and select a theme.</td>
</tr>
<tr>
<td><strong>Remove a Picture’s Background:</strong> Select a picture, click the <strong>Format</strong> tab, and click the <strong>Remove Background</strong> button. Areas that will be removed are highlighted. Click the <strong>Mark Areas to Keep</strong> button to draw over any area accidentally highlighted, and click the <strong>Mark Areas to Remove</strong> button to draw over any area that needs to be removed. Click the <strong>Keep Changes</strong> button.</td>
<td><strong>Position an Object on the Page:</strong> Select an object, click the <strong>Format</strong> tab, click the <strong>Position</strong> button, and select a position.</td>
<td><strong>Use a Document Template:</strong> Click the <strong>File</strong> tab, click <strong>New</strong>, search for a template in the search field or select a recommended template, select a template, and click <strong>Create</strong>.</td>
</tr>
<tr>
<td><strong>Insert a Text Box:</strong> Click the <strong>Insert</strong> tab, click the <strong>Text Box</strong> button, and select a style of text box.</td>
<td><strong>Wrap Text Around an Object:</strong> Select an object, click the <strong>Format</strong> tab, click the <strong>Wrap Text</strong> button, and select a text wrapping style.</td>
<td><strong>Create a Document Template:</strong> Click the <strong>File</strong> tab, click <strong>Save As</strong>, select a location, give the file a name, click the <strong>Save As Type</strong> list arrow, select <strong>Word Template</strong>, and click <strong>Save</strong>.</td>
</tr>
<tr>
<td><strong>Insert a Shape:</strong> Click the <strong>Insert</strong> tab, click the <strong>Shapes</strong> button, select a shape, then click to place a shape (or click and drag to place the shape at a certain size).</td>
<td><strong>Move an Object Up or Down One Layer:</strong> Select an object, click the <strong>Format</strong> tab, and click the <strong>Bring Forward</strong> button to move the object forward one layer, or click the <strong>Send Backward</strong> button to send the object backward one layer.</td>
<td><strong>Long Documents</strong></td>
</tr>
<tr>
<td><strong>Format a Shape:</strong> Select a shape, then click the <strong>Format</strong> tab and use the options in the <strong>Shape Styles</strong> group to customize the appearance of the shape.</td>
<td><strong>Move an Object to the Front or Back:</strong> Select an object and click the <strong>Format</strong> tab. Click the <strong>Bring Forward</strong> button list arrow and select <strong>Bring to Front</strong> to bring the object to the front-most layer. Or, click the <strong>Send Backward</strong> button list arrow and select <strong>Send to Back</strong> to move the object to the back-most layer.</td>
<td><strong>Use Outline View:</strong> Click the <strong>View</strong> tab and click the <strong>Outline</strong> button.</td>
</tr>
<tr>
<td>• Click the <strong>Shape Fill</strong> button and select a color to change the shape’s fill color.</td>
<td><strong>Group Objects:</strong> Select multiple objects, click the <strong>Format</strong> tab, click the <strong>Group Objects</strong> button, and select <strong>Group</strong>.</td>
<td><strong>Demote Items:</strong> While in Outline view, click the item you want to demote and click the <strong>Demote</strong> button (or the <strong>Demote to Body Text</strong> button).</td>
</tr>
<tr>
<td>• Click the <strong>Shape Outline</strong> button and select a color and weight for the shape’s outline, as well as dash and arrow styles.</td>
<td><strong>Ungroup Objects:</strong> Select a group, click the <strong>Format</strong> tab, click the <strong>Group Objects</strong> button, and select <strong>Ungroup</strong>.</td>
<td><strong>Promote Items:</strong> While in Outline view, click the item you want to promote and click the <strong>Promote</strong> button (or the <strong>Promote to Heading 1</strong> button).</td>
</tr>
<tr>
<td>• Click the <strong>Shape Effects</strong> button and select a shape effect, such as shadow, glow, or bevel.</td>
<td><strong>Align Objects:</strong> Select multiple objects, click the <strong>Format</strong> tab, click the <strong>Align</strong> button, and select an alignment option.</td>
<td><strong>Navigate Long Documents:</strong> Click the <strong>View</strong> tab, check the <strong>Navigation Pane</strong> check box, and use the Pages tab to browse by page, or use the Headings tab to navigate by headings.</td>
</tr>
<tr>
<td>• Select a shape style preset from the Shape Styles gallery. Click the gallery’s <strong>More</strong> button to expand the gallery to see more presets.</td>
<td><strong>Distribute Objects:</strong> Select multiple objects, click the <strong>Format</strong> tab, click the <strong>Align</strong> button, and select Distribute Horizontally or Distribute Vertically.</td>
<td><strong>Add a Bookmark:</strong> Select the text you want to bookmark, click the <strong>Insert</strong> tab, click the <strong>Bookmark</strong> button in the Links group, give the bookmark a name, and click <strong>Add</strong>.</td>
</tr>
<tr>
<td><strong>Insert WordArt:</strong> Click the <strong>Insert</strong> tab, click the <strong>Insert WordArt</strong> button, and select a style of WordArt.</td>
<td><strong>Apply a Style:</strong> Place the text cursor in a paragraph and select a style from the Styles gallery on the Home tab. Click the gallery’s <strong>More</strong> button to see additional styles.</td>
<td><strong>Insert a Section Break:</strong> Place the cursor where you want the section to start, click the <strong>Layout</strong> tab, click the <strong>Breaks</strong> button, and select a type of section break.</td>
</tr>
<tr>
<td><strong>Insert a Chart:</strong> Click the <strong>Insert</strong> tab, click the <strong>Add a Chart</strong> button, select a chart category on the left, select a chart type, and click <strong>OK</strong>. Edit the chart data in the window that opens.</td>
<td><strong>Display the Styles Pane:</strong> Click the dialog box launcher in the <strong>Styles</strong> group on the Home tab.</td>
<td><strong>Insert a Hyperlink:</strong> Select the text you want to use as a link, click the <strong>Insert</strong> tab, click the <strong>Link</strong> button, choose what type of link to create, choose where to link to, and click <strong>OK</strong>.</td>
</tr>
<tr>
<td><strong>Resize an Object:</strong> Select an object, then click and drag the sizing handles on the sides and corners until it’s the size you want.</td>
<td><strong>Create a Style:</strong> Select some text that’s formatted the way you want the style to appear, then click the Styles gallery’s More button and select <strong>Create a Style</strong> (or, click the <strong>New Style</strong> button in the Styles pane). Give the new style a name and click <strong>OK</strong>.</td>
<td><strong>Create Footnotes and Endnotes:</strong> Click the text that you want the footnote / endnote to refer to, click the <strong>References</strong> tab, click the <strong>Insert Footnote</strong> button (or <strong>Insert Endnote</strong> button), and type your footnote / endnote.</td>
</tr>
<tr>
<td><strong>Move an Object:</strong> Select an object, then click and drag it to a new location.</td>
<td><strong>Update a Style:</strong> Change the formatting for some text with a style applied, right-click the style in the Styles gallery (or in the Styles pane) and select <strong>Update ___ to Match Selection</strong>.</td>
<td><strong>Insert a Table of Contents:</strong> Place the text cursor where you want to insert a table of contents, click the <strong>References</strong> tab, click the <strong>Table of Contents</strong> button, and select a table of contents style.</td>
</tr>
<tr>
<td><strong>Rotate an Object:</strong> Select an object, then click and drag the rotate handle to the left or right. Or, select an object, click the <strong>Format</strong> tab, click the <strong>Rotate Objects</strong> button, and select a rotation option.</td>
<td><strong>Change Style Sets:</strong> Click the <strong>Design</strong> tab and select a style set from the gallery in the Document Formatting group. Click the gallery’s More button to see additional style sets.</td>
<td><strong>Insert an Index Entry:</strong> Select the text you want the index entry to refer to, click the <strong>References</strong> tab, and click the <strong>Mark Entry</strong> button. Set any index entry options you want, then click <strong>Mark</strong> (or, click <strong>Mark All</strong> to mark all instances of the text). Click <strong>Close</strong>.</td>
</tr>
<tr>
<td><strong>Flip an Object:</strong> Select an object, click the <strong>Format</strong> tab, click the <strong>Rotate Objects</strong> button and select Flip Vertical or Flip Horizontal.</td>
<td><strong>Insert an Index:</strong> Place the text cursor where you want to insert an index, click the <strong>References</strong> tab, click the <strong>Insert Index</strong> button. Set up the index’s options, then click <strong>OK</strong>.</td>
<td><strong>© 2018 CustomGuide, Inc.</strong></td>
</tr>
</tbody>
</table>
Interactive Training for 300+ Skills
Start your free trial today: www.customguide.com

Office for Windows
- Access
- Excel
- Office 365
- OneNote
- Outlook
- PowerPoint
- Word

Productivity
- OneDrive
- Project
- Salesforce
- SharePoint
- Skype for Business
- Windows 10
- ...and more!

Google Suite
- Google Docs
- Google Drive
- Google Sheets
- Google Slides

Office for Mac
- Excel
- PowerPoint
- Word

Also Available
- Spanish Editions

Courses Include:
- ✔ Interactive Tutorials
- ✔ Skill Assessments
- ✔ Customizable Courseware
- ✔ Quick References

Trusted Partner of 3,000+ Organizations